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About This Guide

The IRIX NetWorker User’s Guide documents the Silicon Graphics®
implementation of Legato NetWorker® from Legato Systems, Inc. IRIX
NetWorker is adapted from the Legato™ 4.1.1 release of NetWorker. This
guide was prepared in conjunction with Release 4.1.1 of IRIX NetWorker™
Release 5.3 and 6.x.
The IRIX NetWorker User’s Guide contains instructions on using NetWorker’s
backup and recover software from a client workstation. It shows you how to
back up files and directories to the NetWorker server as needed using the
Backup window, and how to browse the online index to recover files using
the Recover window. It also explains how to use NetWorker archiving and
retrieval, if these optional features are available at your site.

Audience
Those who will benefit most from this manual are users and system
administrators who use NetWorker to back up and recover data from a client
workstation.

Contents of This Guide
The IRIX NetWorker User’s Guide contains information on day-to-day
NetWorker tasks such as backup and recovery.
Chapter 1, “Introduction to NetWorker,” introduces NetWorker basics and
gives instructions for installing NetWorker on clients.
Chapter 2, “Getting Started,” explains the procedures for starting the
NetWorker backup and recover programs, using the Help feature, and using
menus and windows in NetWorker.

xiii

About This Guide

Chapter 3, “Browsing Filesystems,” explains how to view directories and file
details in NetWorker, and how to mark and unmark files for backup and
recovery.
Chapter 4, “Backing Up and Recovering Data,” gives detailed instructions
for backing up and recovering data.
Chapter 5, “Archiving and Retrieving,” explains how to use NetWorker’s
optional archiving feature and how to retrieve archived data.
Appendix A, “Error Messages,” lists NetWorker error messages and
suggests solutions for the problems they address.
Appendix B, “Commands for Backup and Recovery,” summarizes
NetWorker commands you can use in an IRIX shell.
Appendix C, “Requirements for NetWorker Clients,” lists requirements for
Silicon Graphics NetWorker clients to use the NetWorker server to back up
and recover files.
This guide concludes with a glossary of terms and an index.

Conventions
This manual uses conventions to make information easy to access and
understand. The following list describes the conventions.
•

Command names are displayed in italics. For example:
To start the NetWorker recover program, use the nwrecover command.

•

Examples of what you type are displayed in bold, fixed-width typeface.
For example:
atlas% /usr/etc/networker &

•

Names of buttons are displayed in italics. For example:
Press the Cancel button to close the Help window.

•

xiv

Important pieces of information and cautionary notes that prevent you
from making a mistake are marked with the tag “Note.” For example:

Other Documentation

Note: Remember that if you select a server other than the server that
performs your scheduled backups, you must recover your files from that
server.

•

Tips or suggestions that you do not have to follow but are hints for
using NetWorker are marked with the tag “Tip.” For example:
Tip: Keep the Main window open during every backup or recovery to

monitor the progress of the session.
•

Directory pathnames, machine names, and new terms are displayed in
italic typeface. For example:
To back up programs in the directory /usr/etc, follow these steps.
When you use NetWorker to back up your files, you are saving them to
backup volumes on the NetWorker server.

Other Documentation
For information on server configuration and administration, refer to the
IRIX NetWorker Administrator’s Guide.
To get information about a specific release of IRIX NetWorker, see the IRIX
NetWorker Release Notes.
If you would like more technical information about the NetWorker
commands, see the online reference pages after you have installed
NetWorker.
Both the IRIX NetWorker User’s Guide and IRIX NetWorker Administrator’s
Guide are available online, as InSight manuals. Install the subsystems
networker4.books.NetWorker_UG and networker4.books.NetWorker_AG; use
insight(1) to view the manuals.

Product Support
Silicon Graphics offers a comprehensive product support and maintenance
program for its products. For information about using support services for
this product, refer to the Release Notes that accompany it.
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Chapter 1

1.

Introduction to NetWorker

IRIX NetWorker is an easy-to-use network backup and recover product.
Every user knows about accidental file loss and hard disk crashes. With
NetWorker, you can easily protect your valuable files from loss by
performing backups as your needs dictate, in addition to the automatic
backups scheduled by your system administrator. NetWorker allows
straightforward recovery, which lets you find and retrieve lost files easily
and quickly.
NetWorker allows fast file recovery, which means you do not have to waste
time recreating lost files. Just scroll through the window of previously
backed-up files to find the ones that were lost. NetWorker can list multiple
versions of a file that were backed up over time and lets you select the ones
you want to recover. NetWorker provides access to these powerful features
through an intuitive graphical user interface.

NetWorker Basics
The NetWorker server is a machine with a backup device that automatically
backs up systems on a network. Once your system administrator installs
NetWorker and configures the NetWorker server to recognize your system
as a NetWorker client, your files will automatically be backed up to the
NetWorker server. However, you can request NetWorker to back up
important files at any time.
When you use NetWorker to back up your files, you are saving them to a
backup volume on the NetWorker server. The NetWorker server keeps an
online index of the backed-up files for you to browse when you want to
recover a single file or a complete directory.
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After the NetWorker client software is installed and enabled on your system,
as described in the next section, the system administrator will configure the
NetWorker server so that you can use the backup and recover services.

Installing NetWorker Software on Clients
Follow the procedure in this section to install Networker client software.
Because licenses for NetWorker clients are not installed on the clients, no
enabling of the client software is required.
1.

On the client, become root and give the inst(1M) command:
% /bin/su Password:
# inst

2.

Specify the location of the NetWorker software distribution and get a
list of the subsystems, for example:
Inst> from /CDROM/dist
Inst> list

For additional information on inst, see the IRIS Software Installation
Administrator’s Guide.
3.

Make subsystem selections in inst. Use Table 1-1 to guide you in
selecting subsystems. Subsystems not listed in Table 1-1 should not be
installed on clients. For example, to install the required software,
references pages, release notes, and InSight versions of the NetWorker
manuals on an IRIX 5.3 client, give these commands:
Inst>
Inst>
Inst>
Inst>

keep *
install networker4.*.client_5
install networker4.man.relnotes
install networker4.books.*

For additional information on these subsystems, see the IRIX NetWorker
Release Notes.
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Table 1-1

Subsystems for NetWorker Clients

Subsystem

Description

Required/Optional

networker4.sw.client_4

NetWorker client
software

Required (install on
systems running IRIX
4.0.x only)

networker4.sw.client_5

NetWorker client
software

Required (install on
systems running IRIX
5.x only)

networker4.man.client_4

Reference pages for
NetWorker client
software

Optional (install on
systems running IRIX
4.0.x only)

networker4.man.client_5

Reference pages for
NetWorker client
software

Optional (install on
systems running IRIX
5.x only)

networker4.books.NetWorker_UG

The InSight version of
this guide, viewable
with insight(1)

Optional on systems
running IRIX 5.x;
cannot be installed on
systems running IRIX
4.0.x

networker4.books.NetWorker_AG

The InSight version of
the IRIX NetWorker
Administrator’s Guide

Optional on systems
running IRIX 5.x;
cannot be installed on
systems running IRIX
4.0.x

networker4.sw.archive.client_5

Optional archive and
retrieve client software

Requires purchase of
TurboPak option

4.

Perform the installation and exit inst:
Inst> go
Inst> quit
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5.

Check to see if the hostname alias nsrhost has been set to your
NetWorker server:
jupiter% /usr/etc/ping -c1 nsrhost
PING mars.engr.xyz.com (192.48.155.20): 56 data bytes
...

In the command, the -c is followed by a 1. The first line of output
should contain the name of the NetWorker server.
If the output doesn’t contain the name of the NetWorker server, the
networker command won’t automatically connect you to your server;
you’ll have to use the “Change Server” command on the File pulldown
menu to specify your server.
To set the hostname alias nsrhost to your NetWorker server, follow the
directions in the section “Configuring Clients to Recognize the Server”
in Chapter 2 of the IRIX NetWorker Administrator’s Guide or ask your
system administrator to help you.
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2.

Getting Started

This chapter introduces you to backing up and recovering files using IRIX
NetWorker. This chapter assumes that NetWorker client software has been
installed and enabled on your system (see the section “Installing NetWorker
Software on Clients” in Chapter 1) and that your system administrator has
configured the NetWorker server to recognize your system as a client (see
“Configuring a Server’s Clients” in Chapter 6 of the IRIX NetWorker
Administrator’s Guide).
If NetWorker has been installed on your system, you will see the icons, as
shown in Figure 2-1, or you will see the Networker Backup and Recover
windows on your screen.

Figure 2-1

Networker Backup and Recover Icons

This chapter explains
•

starting the NetWorker backup and recover programs

•

using NetWorker menus

•

using NetWorker windows

•

using Help

The chapter concludes with a Quick Tour, in which you back up your current
directory and recover a file using NetWorker.
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Starting the NetWorker Backup and Recover Programs
If the NetWorker backup and recover icons are available, click on them to
open the programs. Otherwise, to invoke NetWorker, change to your home
directory or a local filesystem:
% cd your_home_directory

Then enter the nwbackup or nwrecover command at a shell prompt,
followedby an ampersand (&) to run NetWorker in the background:
% nwbackup &
% nwrecover &

If you want to specify a server, invoke the programs as follows:
% nwbackup -s server_name &
% nwrecover -s server_name &

Tip: You can invoke NetWorker from any directory. The files in the directory

you invoke NetWorker from are immediately available for backup.

Using NetWorker Menus
NetWorker uses windows, pulldown menus, and dialog boxes to guide you
in backing up and recovering files. To use NetWorker menus, you can point
and select with a mouse, or use keyboard shortcuts.
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•

To pull down a menu with the mouse, move the mouse so its arrow
points to your menu choice. Hold down the left mouse button; the
menu appears. With the mouse button still held down, move the mouse
arrow to the desired command in the menu, and then release the button
to make your choice.

•

To pull down a menu using the keyboard shortcuts, hold down the
[Alt] key and press the key that corresponds to the underlined letter of
the selected menu; the menu appears. After releasing both keys, press
the key that corresponds to the underlined letter in the command name.

Using NetWorker Windows

Using NetWorker Windows
NetWorker displays your files and directories using icons and windows.
NetWorker windows provide an easy-to-use X Window System graphical
user interface. This section shows you how to use NetWorker windows.
Figure 2-2 shows the Backup window and its components.

Menu bar
Speedbar
Selection
panel
Highlighted
directory
Directory icon
File icon

Mount point icon

Directory display

Figure 2-2

File display

Backup Window

The next sections describe the components of the Backup window.

Menu Bar
The menu bar contains the File, Tree, View, Change, Mark, Options, and
Help pulldown menus.
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To use these menus, position the cursor over the desired menu and hold
down the left mouse button to display the pulldown menus. By X Window
System convention, the first command in the menu is always selected by
default.
Tip: The left and right mouse button actions used in this manual are the

X Window System defaults. If you have problems using the mouse, your
mouse buttons may have been reprogrammed. See your system
administrator for help.

Speedbar
The speedbar is identical in both the Backup and Recover windows. Clicking
a speedbar button is the same as choosing the command from the menu.
Figure 2-3 shows the speedbar.

Figure 2-3

Speedbar

The five graphical buttons on the speedbar are shortcuts for the following
actions:
•

Change Server allows you to switch to a different NetWorker server.

•

Mark marks directories or files.

•

Unmark unmarks directories or files.

•

Find allows you to search for directories or files.

•

Start starts the backup or recover operation.

Online Help
To use online help, select the Help pulldown menu of the window in
question to read the online help message. You can obtain help on the current
window, menu item, or dialog box. See “Using Help” later in this chapter for
details.
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Selection Panel
The selection panel in the Backup and Recover windows indicates the
current server and client. The Recover window also displays the browse
Time.
The Selection field displays the full pathname of the current file or directory
and allows you to enter text to select any pathname you choose.

Directory and File Display Areas
The window is divided into two display areas: a directory display on the
left-hand side and a file display on the right-hand side. The size of the file
display can be adjusted horizontally to make it easier to see your files. The
entire window can be adjusted vertically. The display areas contain icons
that represent the files and directories in your filesystem.

Icons
Use the checkbox next to each icon to mark and unmark files and directories
for backup or recovery.
A folder icon, shown in Figure 2-4, represents a directory.

Figure 2-4

Directory Icon

An open folder, shown in Figure 2-5, indicates that the tree structure of the
directory, if one exists, appears in the directory display.

Figure 2-5

Open Directory Icon
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A highlighted open folder, shown in Figure 2-6, indicates that the tree
structure of the directory, if one exists, appears in the directory display. It is
the current selection.

Figure 2-6

Directory Structure Icons for a Selected Directory

A gray checkbox for a directory indicates that a subdirectory has been
marked for backup or recovery.
A highlighted folder, shown in Figure 2-7, indicates the current selection.
The folder contents appear in the file display. A highlighted folder is selected
for menu actions.

Figure 2-7

Current Selection Icon

The icon in Figure 2-8 represents mount points.

Figure 2-8

Mount Point Icon

A sheet icon, shown in Figure 2-9, represents a file.

Figure 2-9
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File Icon

Using NetWorker Windows

A highlighted file, shown in Figure 2-10, is selected for menu actions.

Figure 2-10 Highlighted File Icon

A chain icon, shown in Figure 2-11, represents a symbolic link.

Figure 2-11 Symbolic Link Icon

A brick icon, as shown in Figure 2-12, represents a block device.

Figure 2-12 Block Device Icon

The icon shown in Figure 2-13 represents a character device.

Figure 2-13 Character Device Icon

The cursor changes to a clock, shown in Figure 2-14, when NetWorker is
performing a task.

Figure 2-14 Clock Cursor Icon

Window Controls
Select the scroll bar or the triangular endpoints of a scroll bar, or drag the
slide, to navigate vertically or horizontally in the directory and file displays.
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Using Help
You can learn about NetWorker by using the Help windows. You can also get
online help on any menu item or window component. To display online
help, select the Help menu of the window in question by clicking the word
Help at the far right of the menu bar. You can obtain help on the current
window, menu item, or dialog box.
In each window, the Help pulldown menu (see Figure 2-15) provides you
with help on the window, a list of help topics to browse, directions on using
help, and information on the version of NetWorker you are using.
Help

On Window
On Topic
On Help
On Version
Figure 2-15 Help Pulldown Menu

Select the Topic command in the Help pulldown menu to open the Topics
Help window, as shown in Figure 2-16.
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Figure 2-16 Topics Help Window

To see more information about a topic, select the title from the Topics
scrolling list. The help text for the selected topic appears in the top window.
The Topics scrolling list remains available in the bottom window for
selecting other topics.
For example, selecting the topic “Backup” produces the window shown in
Figure 2-17.
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Figure 2-17 Backup Help Window

To return to the Backup window, click the Cancel button.
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Quick Tour
This Quick Tour shows you how to back up your current directory and how
to recover a file using NetWorker. Follow the instructions in this section to
become familiar with the product. Chapter 3 and Chapter 4 have more
detailed information on how to use it.

Backing Up Your Directory
To demonstrate NetWorker functionality, first back up a directory to the
NetWorker server. The Backup window lets you browse the filesystem to
examine your directories. Then you can mark files for backup.
To learn about NetWorker, you will mark an entire directory for backup.
Then you will unmark a file within that directory. Finally, you will start the
backup.
If the NetWorker Backup window, is not open on your screen, select the
NW Backup icon to open the window. The Backup Window is shown in
Figure 2-18.

15
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Figure 2-18 Backup Window

The Selection field displays the pathname of the directory from which you
invoked NetWorker. The directory display shows you a graphical
representation of the path, with the current directory highlighted. The file
display shows you the contents of the current directory.
The backup procedure consists of

16

•

expanding the current directory

•

marking a directory

•

unmarking a file

•

starting the backup

•

closing the Backup window

Quick Tour

Expanding the Current Directory

To find a lower-level directory to mark for backup, expand the current
directory one level. Select “Expand One Level” from the Tree pulldown
menu, as shown in Figure 2-19.
Tree
Expand One Level
Expand Branch
Collapse Branch
Figure 2-19 ”Expand One Level” on the Tree Menu, Backup Window

The directory display shows the expanded directory, as shown in
Figure 2-20.

Figure 2-20 Directory Display in the Backup Window
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Marking a Directory

To mark a directory for backup, use the mouse to select the checkbox next to
the folder that represents the directory that you want to back up, as shown
in Figure 2-21.

Figure 2-21 Directory Marked for Backup

Notice that a checkmark (✓) appears in the checkbox. Highlight the folder to
display its files. In the file display, notice that the files contained in the
marked directory are also marked, as shown in Figure 2-22.

Figure 2-22 File Display in the Backup Window

Tip: You can also mark a directory by highlighting it and selecting the Mark

speedbar button. The effect is the same as selecting the checkbox.
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When you mark a directory, its nested files and subdirectories are marked as
well. The checkboxes of the parent directories turn gray to indicate that a
subdirectory has been marked. Mount points within a marked directory are
not marked, since you can only mark files within one filesystem at a time.
Unmarking a File

You can exclude a file from the backup by unmarking it. In the file display,
select the checkmark next to a file to unmark it. The checkmark disappears
and the file is excluded from the backup. In Figure 2-23, the last file is
excluded from the backup.

Figure 2-23 Included and Excluded Files in the File Display of the Backup Window

Tip: You can also unmark a file by highlighting it and selecting the Unmark

speedbar button The effect is the same as selecting the checkmark.
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Starting the Backup

After you have finished marking files, you are ready to start the backup.
Click the Start speedbar button to start the backup.
Before the backup starts, the Backup Options dialog box appears, as shown
in Figure 2-24.

Figure 2-24 Backup Options Dialog Box

In the Backup Options dialog box, you tell NetWorker whether or not you
want your files compressed during the backup. For this example backup,
compress the files.
Notice that “Yes” is highlighted after the question “Do you want to
compress this backup?” This means it is the default choice, so click the Ok
button to continue the backup with file compression.
Note: You can also exclude patterns in the Backup Options dialog box. For

information on excluding patterns, see Chapter 4, “Backing Up and
Recovering Data.”
The Backup Status window appears, as shown in Figure 2-25, where you can
monitor the progress of your backup.
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Figure 2-25 Backup Status Window

Tip: If you do not see any files scrolling in the display, or if you see an error

message, contact your system administrator. The server may be busy
recovering, or it may have a configuration problem. Or, the backup volume
may not be mounted in the device. You can check the main window as
described in the next section to see if the backup volume is mounted.
When your backup is complete, you will see a message similar to this in the
Backup Status window:
Backup Completion Time: Wed Jun 21 11:20:03 1995

NetWorker backed up the files you marked to the volume mounted in the
server device. It also created an index on the NetWorker server for your
client machine. Any file that you back up in the future will have an entry in
this index, so that you can find it quickly.
Select the Cancel button to close the Backup Status window.
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Closing the Backup Window

Close the Backup window by clicking the minimize button in the window
header.
If you want to exit Networker (and thus stop the program), select “Exit”
from the File menu, as shown in Figure 2-26.
File

Exit
Figure 2-26 “Exit” on the File Menu of the Backup Window

Recovering a File
The index that is created on the NetWorker server when you back up files is
displayed in the Recover window. The index looks similar to the filesystem
that is pictured in the Backup window.
To recover a file, you browse the index for a directory and mark a file within
that directory. Then you start the recovery.
If the Recover window is not already open, select the NW Recover icon on
your screen to open it. Figure 2-27 shows the Recover window.
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Figure 2-27 Recover Window

Tip: In the Recover window you are looking at the index for your files on

the NetWorker server, not the filesystem on your system that the Backup
window shows. The Recover window shows the entries for those files that
have been backed up and are available for recovery. The entries are
organized exactly like the actual filesystem, so it is easy for you to navigate
around the directories.
The recover procedure consists of
•

browsing the index

•

starting the recovery

•

closing the Recover window
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Browsing the Index

You can browse the index to locate a file that you want to recover. Follow
these steps:
1.

Notice that the current directory is highlighted.

2.

Select “Expand One Level” from the Tree pulldown menu. The
subdirectories are displayed in a tree structure in the directory display,
as shown in Figure 2-28.
Tree
Expand One Level
Expand Branch
Collapse Branch

Figure 2-28 ”Expand One Level” on the Tree Menu of the Recover Window

Tip: Selecting a closed directory folder twice (double-clicking) also

expands it one level, as shown in Figure 2-29.

Figure 2-29 Expanding a Directory One Level
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3.

Highlight the directory folder that contains the desired file by selecting
it. The file display shows the most recently backed-up version of the
files contained in the directory.

4.

Mark the files you wish to recover by selecting their checkboxes in the
file display, as shown in Figure 2-30.

Quick Tour

Figure 2-30 Marking Files to Recover in the Recover Window
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Starting the Recovery

So far you have browsed the index and marked files for recovery. You are
now ready to start the recovery. Follow these steps:
1.

Click the Start speedbar button to start the recovery. The Conflict
Resolution dialog box appears, as shown in Figure 2-31, before the
recovery starts.

Figure 2-31 Conflict Resolution Dialog Box

In the Conflict Resolution dialog box, you tell NetWorker what to do if
a naming conflict is encountered during recovery. A naming conflict
occurs when the file you are recovering has the same name as a file that
already exists in one of the directories you are trying to recover.
2.

For this example, select “No” so that NetWorker does not prompt you
for each naming conflict.
“Rename the recover file” is now highlighted as the default selection.
This command places a .R extension after the name of the recovered file
when a naming conflict occurs with an existing file.
Tip: You can rename a file during recovery so that if a file with the same

name exists, it will not be overwritten.
3.

Click Ok to close the Conflict Resolution dialog box and continue the
recovery.
The Recover Status window appears, as shown in Figure 2-32. You can
monitor the progress of the recovery in the Recover Status window.
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Quick Tour

Figure 2-32 Recover Status Window

The Recover Status window provides information about your recovery,
including the name(s) of the backup volumes needed and their location. The
Recover Status window also displays the number and names of the files
being recovered, and their new names if they are being renamed.
You can cancel the recovery by clicking the Cancel button in the Recover
Status window.
The following message appears when the recovery is complete:
Received 5 files from NSR server `atlas`

To confirm its recovery, you can look for your file in the filesystem by listing
the contents of the directory in an IRIX shell. The recovered file has a .R file
extension because you told NetWorker to rename the file in the Conflict
Resolution dialog box.
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Quick Tour Review
During the Quick Tour of NetWorker, you learned how to:
•

use the NetWorker graphical user interface

•

use the Backup window to back up your directory to the NetWorker
server

•

monitor the status of your backup

•

use the Recover window to browse the index for your backed-up files

•

mark a file for a recovery in the Recover window

•

recover a file

•

resolve a naming conflict during recovery

•

monitor the status of the recovery

The Quick tour is meant to familiarize you with the NetWorker Backup and
Recover windows. Chapter 3 and Chapter 4 provide detailed information on
performing backups and recovers.
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3.

Browsing Filesystems

The NetWorker graphical user interface allows you to browse your
filesystems, including directories, subdirectories, and nested files. Since the
filesystem is represented by icons on the screen, it is easy to select files and
directories for backup. For recovering files, the index of saved files is
displayed graphically like the filesystem, making it convenient to select files
for recovery.
This chapter explains
•

viewing your directories

•

marking and unmarking files

•

viewing file details

•

searching for files

•

changing a selection

•

exiting from a window

Note: This chapter describes the features common to both the backup and
recover windows that are used for viewing directories. The features specific
to a window are described in Chapter 4, “Backing Up and Recovering Data.”
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Viewing Your Directories
You can expand a directory to one level to view its subdirectories, or you can
view all levels of a directory by expanding a branch. Thus it is easy to find
files that are deeply embedded in your filesystem.
Use the Tree menu to select the level at which you wish to browse the
directories in the filesystem.

Expanding to One Level
Choosing the “Expand One Level” command, as shown in Figure 3-1, opens
a directory to display the subdirectories one level below. The subdirectories
are graphically displayed as a tree structure in the directory display. You can
scroll in the directory display to find the subdirectory that contains the
desired file. Large directories might take a few minutes to expand.
Tree
Expand One Level
Expand Branch
Collapse Branch
Figure 3-1

“Expand One Level” in the Tree Menu of the Backup Window

To expand a directory to one level, follow these steps:
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1.

Highlight a directory folder in the directory display.

2.

Select “Expand One Level” from the Tree pulldown menu, or
double-click the directory folder.

Marking and Unmarking Files

Expanding a Branch
The “Expand Branch” command lets you view all the levels of subdirectories
in a directory. Large branches may take a while to expand.
To expand a directory to view the branch, follow these steps:
1.

Highlight a directory in the directory display.

2.

Select “Expand Branch” from the Tree pulldown menu.

Collapsing a Branch
The “Collapse Branch” command closes all subdirectories and returns you
to the level of the highlighted directory.
To collapse a branch, follow these steps:
1.

Highlight an expanded directory in the directory display.

2.

Select “Collapse Branch” from the Tree pulldown menu, or
double-click the directory folder.

Marking and Unmarking Files
You choose files and directories for backup and recovery by marking them.
The icons have a checkbox beside them that displays a checkmark when the
file is marked. You can mark or unmark files and directories by using either
the File pulldown menu or the checkbox.
To mark a file or directory using the File menu, follow these steps:
1.

Highlight a file or directory icon by selecting it with the mouse.

2.

Click the Mark speedbar button, as shown in Figure 3-2.

Figure 3-2

Mark Speedbar Button
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This action places a checkmark in the checkbox beside the highlighted
icon (see Figure 3-3) to mark it for backup or recovery.

Figure 3-3

3.

Icon Marked for Backup or Recovery

If you decide that a file should not be included in the backup or
recovery, highlight the icon and select the Unmark speedbar button to
remove the checkmark. Figure 3-4 shows this button.

Figure 3-4

Unmark Speedbar Button

To mark a file using the checkbox, follow these steps:
1.

Use the mouse to select the checkbox next to the file. This action places
a checkmark in the checkbox.

2.

Select the checkmark to unmark the file, as shown in Figure 3-5.

Figure 3-5

Unmarking a File

Tip: When you mark a directory, all its subdirectories and nested files are

also marked. The checkboxes of the parent directories turn gray to indicate
that some or all of the directory contents are marked for backup or recovery.
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Viewing File Details
The View pulldown menu contains the File Names and File Details
command, where you can choose to view the file details or only the file
names in the file display. This command toggles between the two choices.
Figure 3-6 shows the View menu.
View

Search...
File Details
Versions...
Volumes...
Figure 3-6

“File Details” on the View Menu of the Recover Window

Use the “Versions” command to display a list of backup versions of your files
that are available for recovery. Use the “Volumes” command to determine if
the file you want to recover is immediately available for a recovery.
By default, NetWorker lists the files in alphabetical order, with only the
filenames displayed. File Details displays the filename, number of blocks,
permissions, number of links and where they point (symbolic links only),
owner, group, size, and date each file was last modified.
In the NetWorker Recover window, the File Details command also displays
the backup time for each file. You can use this data to identify different
backup versions of a file.
To display filenames or file details, follow these steps:
1.

Select “File Details” (or “File Names”) from the View pulldown menu,
as shown in Figure 3-6.

2.

If necessary, adjust the size of the window to display the full File
Details.
Figure 3-7 shows the File Details display in the NW Recover window.
Notice the backup time listed beside each icon.
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Figure 3-7

File Details Display on the Recover Window

Searching for Files
If you know the name or partial name of a file or directory, you can use the
Search window to locate it in the filesystem or index. Use the Search speedbar
button to bring up the Search window, or choose Search from the View
pulldown menu.
To search for files, you specify the filename or partial filename you are
looking for and the directory name where you wish to begin the search.
NetWorker begins searching in that directory and then searches through its
subdirectories and nested files.
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To search for files or directories by name, follow these steps:
1.

Click the Search speedbar button in the speedbar to open the Search
window, or select the Search command from the View pulldown menu.
The Search dialog box appears, as shown in Figure 3-8.

Figure 3-8

Search Dialog Box

2.

Enter the name of the file or directory in the Search for field. You can
use standard IRIX shell pattern characters when specifying partial
filenames.

3.

Enter a valid pathname for the directory where you wish to begin the
search in the “Begin search in” field. NetWorker searches through that
directory and all nested subdirectories.

4.

Click the Ok button. The pathname of the first match appears in the
Selection field and is also highlighted in the file display.

5.

Click the Continue button to highlight the next match. You can continue
the search until the last match is found.
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Changing a Selection
The NetWorker windows display the full pathname of the current directory
in the Selection field. If you know the path of a directory or file, you can go
directly to it by entering the full pathname in the Selection field, as shown in
Figure 3-9.

Figure 3-9

Selection Field

To change the current selection, follow these steps:
1.

Enter the full pathname in the Selection field.

2.

Press the <Enter> key.

Both the directory and file displays change to show the new selection.

Exiting From a Window
The “Exit” command is in the File menu of the NW Backup and NW Recover
windows. This command closes the current window without backing up or
recovering files and exits the program.
Figure 3-10 shows this command.
File

Exit

Figure 3-10 “Exit” on the File Menu

The File menus of various windows in NW Backup and NW Recover also
have a “Close” command. This command closes the window without exiting
the program.
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4.

Backing Up and Recovering Data

This chapter describes the NetWorker Backup and Recover windows and the
backup and recover functions that are unique to each of the windows.
Note: For information on using the functions that are common to both
windows, such as viewing and marking files, see Chapter 3, “Browsing
Filesystems.” For a quick tour of the NetWorker backup and recover
programs, see “Quick Tour” in Chapter 2.

Shortcuts
If you are already familiar with the NetWorker backup and recover
programs, use these shortcut procedures.

Shortcut: Backup
Follow these steps to back up your directories or files:
1.

If necessary, click the NW Backup icon to open the NetWorker Backup
window.

2.

Select the check boxes, or highlight the directory or file you want to
back up, and click the Mark speedbar button.

3.

Click the Start speedbar button.

4.

Click the Ok button in the Backup Options dialog box.

5.

Check the backup completion message to make sure the backup is
complete.

6.

Click the Cancel button in the Backup Status window to close the
window.
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Shortcut: Recover
Follow these steps to recover your directories or files
1.

Select the NW Recover icon to open the NetWorker Recover window.

2.

If necessary, choose a server by clicking the Change Server speedbar
button. If applicable, choose a client by choosing “Client” from the
Change menu.

3.

Using the mouse, highlight the icons for files or directories you wish to
recover, and click the Mark speedbar button for these.

4.

Choose “Volumes” from the View pulldown menu to see if the backup
volumes are available for your recovery.

5.

Click the Start speedbar button to begin the recovery.

6.

Click the Ok button in the Conflict Resolution dialog box.

7.

When you see the recover completion time message in the Recover
Status window, click the Cancel button to close the window.

Backing Up Data
This section assumes that you have already marked your files for backup. If
you need to know how to view directories, mark files, search for files, or
view file details, see Chapter 3, “Browsing Filesystems.”
This section explains
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•

changing the NetWorker server, if necessary

•

starting the backup

•

choosing the backup options

•

monitoring the backup status

Backing Up Data

Changing the NetWorker Server
NetWorker backs up your data according to a schedule determined by your
system administrator. Usually, a single NetWorker server backs up all the
systems on a network. You may need to change servers if your NetWorker
server is down or you are experiencing network difficulties.
If you have more than one NetWorker server available on the network, you
might have a choice of servers for your backups. However, in order to switch
to a different NetWorker server, your system must be listed as a client of that
server. Check with your system administrator before you switch to a server
other than the one that normally backs up your system.
To change the NetWorker server, follow these steps:
1.

Click the Change Server speedbar button, or select Server from the
Change pulldown menu. Figure 4-1 shows these options.

Speedbar
button

Change Server
command

Change
Server...
Figure 4-1

Changing the NetWorker Server

The Change Server dialog box appears, as shown in Figure 4-2.

Figure 4-2

Change Server Dialog Box
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2.

If you know the hostname of the server, enter it in the Server field and
click Ok.
Alternatively, click the Update Server List button to update the list of
NetWorker servers on the network.

3.

Highlight the hostname of a server in the list and click Ok to choose the
new server. You can also double-click a hostname to select it.

4.

Click Ok to choose the new server.
Note: If you choose a NetWorker server that does not have your system

listed as a client, the message shown in Figure 4-3 appears.

Figure 4-3

Client Not Registered Message

Starting a Backup
To start a backup, follow these steps:
1.

Mark the files that need to be backed up.

2.

Choose the NetWorker server (if necessary).

3.

Click the Start speedbar button, or choose “Start Backup” from the File
pulldown menu. These options are shown in Figure 4-4.

Speedbar button

Start Backup command

File

Exit
Figure 4-4

Starting a Backup

NetWorker displays the Backup Options dialog box, which is explained in
the next section.
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Choosing the Backup Options
In the Backup Options dialog box, you can compress files and exclude
patterns before the backup starts. Compressing data reduces network traffic
and can conserve space on the backup media, Excluding patterns is
convenient if you have data you do not want to back up at all.
Caution: Compressing your data during backup can save space on the
backup media and reduces network traffic, but may slow down the backup
operation. Also, if you back up to a device that compresses data, do not use
NetWorker’s file compression feature. Check with your system
administrator to find out if you should compress your data during a backup.
Compressing Files

To choose whether or not to compress the files you back up, answer the
question “Do you want to compress this backup?” in the Backup Options
dialog box, as shown in Figure 4-5. Notice that “Yes” is already highlighted
as the default selection.

Figure 4-5

Backup Options Dialog Box

•

To continue the backup with file compression, you do not have to make
a selection, since Yes is the default selection.

•

To continue the backup without file compression, select “No.”
Note: If you back up to a device that compresses data, select “No.”

41

Chapter 4: Backing Up and Recovering Data

If you do not need to exclude patterns from your backup, click Ok to
continue the backup with your file compression choice.
Excluding Patterns

Before starting a backup, you can exclude patterns in the Backup Options
dialog box. This feature is useful, for example, if you are backing up an entire
directory and do not need to back up certain files or subdirectories in that
directory. Excluding data from the backup also reduces network traffic and
saves space on backup media.
To exclude patterns, specify alphanumeric patterns that occur in the names
of the files that you want to exclude from the backup. Use IRIX shell pattern
characters to specify any number of patterns you wish to exclude.
Notice that “No” is highlighted as the default answer to the question “Do
you want to exclude any patterns from this backup?” If you do not wish to
exclude any patterns of filenames from the backup, select Ok to continue the
backup with only your file compression choice.
To exclude patterns from the backup, follow these steps:
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1.

Select “Yes” to answer the question “Do you want to exclude any
patterns from this backup?” This choice activates the lower half of the
Backup Options dialog box.

2.

Enter the first pattern to be excluded in the Pattern field.

3.

Click Add to add the pattern to the pattern list, as shown in Figure 4-6.

Backing Up Data

Figure 4-6

Excluding a Pattern

Enter any number of patterns and add them to the pattern list.
To change a pattern, select it in the pattern list. The selected pattern
appears in the Pattern field. Enter the new pattern and click Change. The
new pattern replaces the old pattern in the pattern list.
4.

To delete a pattern, select it in the pattern list and click Delete.

5.

Click Ok to continue the backup with the excluded patterns.
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Monitoring the Backup Status
After you complete your selections in the Backup Options dialog box, the
Backup Status window appears, as shown in Figure 4-7. Use the Backup
Status window to monitor the progress of the backup.

Figure 4-7

Backup Status Window

The Backup Status window provides the backup start time and the backup
completion time. The names of the files and directories scroll across the
Backup Status window as the backup proceeds. The save message at the
bottom of the window gives you information about the backup including the
full pathname of the directory and the number of kilobytes and files being
saved.
Note: If after several minutes you do not see any progress messages (after

the “Backup Start” message) in the Backup Status window, the NetWorker
server probably needs attention from the system administrator.
You can cancel the backup by pressing the Cancel button.
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The following message appears in the Backup Status window when the
backup is complete:
Backup completion time: Wed Jun 23 11:20:03 1993

Recovering Data
This section assumes that you have already marked your files for recovery
in the Recover window. If you need to know how to view directories, mark
files, search for files, or view file details, see Chapter 3, “Browsing
Filesystems.”
NetWorker displays entries in the NetWorker Recover window for the files
it saved during a backup. Select the files you wish to recover from this list of
entries. NetWorker’s recover functions allow you to browse the index for
previous backups, select various versions of the file to recover, view your
marked files, relocate files upon recovery, and recover files from another
authorized system.
Note: An authorized system is a client from which you have permission to
recover data.

This section explains
•

choosing the Recover server

•

choosing the Recover client

•

selecting file versions

•

changing the browse time

•

listing marked files

•

listing the backup volumes for a recover

•

relocating files

•

starting the recovery

•

monitoring the recover status
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Choosing the Recover Server
Normally you recover files from the NetWorker backup server chosen for
you by your system administrator. If you have backed up files to a different
server, you must also recover those files from that server. If you changed
servers in the Backup window, select the same server in the NetWorker
Recover window.
Note: The Change Server dialog box lists all the NetWorker servers on the

network. You can recover files only from a server that lists your system as a
client.
To choose a recover server, follow these steps:
1.

Click the NW Recover icon to open the NetWorker Recover window if
it is not already open.

2.

Click the Change Server speedbar button, or select “Server” from the
Change pulldown menu. Figure 4-8 shows the Change Server dialog
box.

Figure 4-8

3.

Change Server Dialog Box

Click the Update Server List button or double-click on the server name to
update the list of NetWorker servers on the network. Choose the server
that has the files you need to recover.
The Server field changes to reflect the current selection. The directory
and file displays are refreshed to show the index for the current server.

4.
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Click the Ok button after you have selected a server.

Recovering Data

Choosing the Recover Client
If you need to recover files from a client other than the system you are
currently using (for example, because the client’s disk was damaged and
files are being restored onto a different system), use the “Change Client”
command in the Change pulldown menu. The “Change Client” command
opens a dialog box that lists all of the NetWorker clients.
Note: Check with your system administrator if you wish to recover files
other than your own. You might not be authorized to recover files for other
client systems.

To choose a recover client, follow these steps:
1.

Choose “Client” from the Change pulldown menu in the Recover
window.
The Change Client dialog box appears, as shown in Figure 4-9.

Figure 4-9

Change Client Dialog Box

2.

To update the list of NetWorker clients, click the Update Client List
button.

3.

Choose a client from which you are authorized to recover files. The
Client field changes to reflect the current selection.
When you recover this client’s files, they are restored onto the system
you are currently using.
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Selecting File Versions
The Versions window lists all the versions of a file or directory that have
been backed up by the backup server. It also lists the locations of the
versions. The information in the Versions window is retrieved from the
index that is created by NetWorker when you perform a backup. Use the
Versions window to view the backup history of a file and to mark a version
for recovery.
Note: NetWorker displays versions of the directories and files in the

Versions window. However, in the Versions window, you can mark only files
for recovery, not directories.
For each version, the Versions window lists
•

number of blocks

•

mode

•

permissions

•

number of links

•

owner

•

group

•

size in bytes

•

last modified time

•

filename

•

backup time (used to identify different versions of a file)

•

location, including
–

name of the backup volume

–

device where the volume is mounted, if any, or the location of the
backup volume (for example, an off-site storage place)
If no device is listed, the backup volume must be mounted before
recovery of the file is possible.
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To view the backup history of a file or directory, follow these steps:
1.

Open the Recover window and highlight a file or directory in the file
display.

2.

Select “Versions” from the View pulldown menu, as shown in
Figure 4-10.
View

Search...
File Details
Versions...
Volumes...
Figure 4-10 “Versions” on the View Menu of the Recover Window

NetWorker retrieves several versions of the highlighted file or directory
from the index and lists them by backup time, beginning with the most
recent. If necessayr, use the scrollbar to view the backup history.
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Figure 4-11 Backup History in the Versions Window

3.

Click More to retrieve ten more versions from the index. The More
button turns gray when all versions have been retrieved.

Note: Remember, you cannot mark directories for recovery in the Versions

window. To mark a past version of a directory and its contents for recovery,
use the “Change browse time” command.
To select a version of a file for recovery, follow these steps:
1.

Select the checkbox of the version that you want to recover.

2.

Click Ok to place the checkmarked versions in the file display.

Tip: When you mark a past version of a file in the Versions window, this

version appears in the NetWorker Recover window file display with the
same name as the recent version. You then have more than one version of a
file in the file display. If you are confused as to which version to mark, use
“File Details” to display their backup times.
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Changing the Browse Time
The Browse Time field displays the date you initiated the browse, unless you
change it to a date in the past. NetWorker displays the currently selected
browse time in the Browse Time field in the Recover window, as shown in
Figure 4-12.

Figure 4-12 Browse Time in the Recover Window

The NetWorker Recover window displays the index entries for previously
backed-up files. Changing the browse time displays the index entries for
files backed up at that time.
Note: If NetWorker has no entries for files backed up for the time selected in
the Browse Time field, NetWorker displays files that were backed up closest
to that time, but not immediately after. For example, if you change the
browse time to 10 a.m. on May 15, and the backup took place at 11 a.m. on
May 15, NetWorker will not display the entries for the files backed up at
11:00 a.m.

Changing the browse time lets you view your files as of some time in the
past. This feature is useful if you do not remember the name or location of
the files you want to recover, but you remember that they existed at a
particular time in the past. The Change browse time command also helps
you find files that have been deleted and thus do not appear in the Versions
window. You can recover deleted files by changing the browse time to locate
past versions of the files in the index.
Tip: Use the “Change browse time” command to browse and mark past

versions of directories. If you mark a directory, all its nested files and
subdirectories are also marked.
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To change the browse time to recover a past version of a file, follow these
steps:
1.

Open the NetWorker Recover window and select “Browse time” from
the Change menu, as shown in Figure 4-13.
Change

Server...
Client...
Browse Time...
Figure 4-13 ”Change Browse Time” on the Change Menu of the Recover Window

The Change Browse Time dialog box appears, as shown in Figure 4-14.

Figure 4-14 Change Browse Time Dialog Box
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2.

Use the Previous, Today, and Next buttons to control the month shown in
the calendar.

3.

When the month you want is displayed, click the desired day in the
calendar.

Recovering Data

You can also change the browse time by entering a date and time in the
Browse Time field and pressing <Enter> or clicking Ok. The following
formats are valid for browse time:

4.

•

hh:mm:ss (24-hour clock); for example, 15:30:00

•

hh:mm (am, pm) (PDT) mm/dd/(yy); for example, 5:30 pm PST
7/4/95

•

monthname dd (yy); for example, October 31

•

last Friday, next Friday, third Friday

•

+ or - 3 seconds, minutes, hours, weeks, months, years

•

now

Click Ok when you are finished choosing a browse time.
The Browse Time field in the NetWorker Recover window changes to
reflect the new browse time. Both the file display and the directory
display show the files that were backed up at that time.
You can now mark past versions of files for recovery.

Note: Any files or directories that you have marked for recovery prior to
changing the browse time remain marked.

Listing Marked Files
You can list the files you have marked for recovery by selecting “Show
Marked” in the Mark menu. Use “Show Marked” to check the files you have
marked for recovery before performing the recover operation. The Files
Marked for Recovery window lists the pathnames and backup time of files
that you have marked for recovery.
To show the files that you have marked for recovery, follow these steps:
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1.

Select “Show Marked” from the Mark menu of the NetWorker Recover
window, as shown in Figure 4-15.
Mark

Mark
Unmark
Show Marked...
Figure 4-15 “Show Marked” on the Mark Menu of the Recover Window

The Files Marked for Recovery window appears, as shown in
Figure 4-16, listing the pathnames and backup time of all marked files.

Figure 4-16 Files Marked for Recovery Window

2.
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Click Cancel to close the window.
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Listing the Backup Volumes for a Recover
After you mark your files for a recovery, you can use the Volumes command
in the View pulldown menu to find out if the backup volumes that
NetWorker needs are available; that is, if the volume is mounted or in a
jukebox. If you start a recover operation, and NetWorker cannot access the
backup volume that has your file, it will send a message to the system
administrator to load the volume. This process can take some time, and you
may not want to begin the recover operation unless you can get your data
back right away.
To determine if the file you want to recover is immediately available for a
recovery, follow these steps:
1.

Mark the files or directories you wish to recover in the NetWorker
Recover window.

2.

Select the “Volumes” command from the View menu, as shown in
Figure 4-17.
View

Search...
File Details
Versions...
Volumes...
Figure 4-17 Volumes Command

NetWorker displays a notice window, as shown in Figure 4-18.

Figure 4-18 Volumes Needed Notice
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If the backup volume is available, that is, the volume is mounted or in a
jukebox, the message all online appears in the notice window. The
window displays the name(s) of the backup volume(s) and, if applicable, the
location of the volumes. In the example in Figure 4-18, the volume is named
LOC5G234 and is located in a jukebox belonging to the engineering
department.

Relocating Files
Before you start a recovery, use the optional “Relocate” command to place
your files in a directory other than the one in which they were located when
they were backed up. “Relocate” creates the directory, if it does not already
exist. You can also relocate files to an existing directory by entering the
complete pathname.
To relocate recovered files into a new or existing directory, follow these steps:
1.

Open the NetWorker Recover window and select “Relocate” from the
Options menu, as shown in Figure 4-19.

Options

Speedbar
Relocate
Figure 4-19 “Relocate” on the File Menu of the Recover Window

The Relocate dialog box appears, as shown in Figure 4-20.

Figure 4-20 Relocate Dialog Box

2.
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In the “Relocate to” field, enter the name of the directory where the
recovered files will be stored. Be sure to include the complete pathname
of the directory.

Recovering Data

3.

Click Ok to relocate the files into the new directory.

Renaming or Overwriting Recovered Files
When you start a recover, NetWorker displays the Conflict Resolution dialog
box. Use this box to rename recovered files or overwrite existing files when
a naming conflict occurs. A naming conflict occurs when a file you are
recovering already exists or has the same name as a file in the current
directory. NetWorker does not overwrite existing files unless you request it
to do so.
The Conflict Resolution dialog box, shown in Figure 4-21, asks two
questions about resolving naming conflicts.

Figure 4-21 Conflict Resolution Dialog Box

To use the Conflict Resolution dialog box, follow these steps:
1.

Answer the question, “Do you want to be prompted when conflict
occurs?”
•

If you select “No,” you must make a choice for the next question in
the box, “When conflict occurs, NetWorker should?”
Answering this question allows you to resolve conflicts for the
entire recover session without being prompted about each
individual file.

•

If you select “Yes,” the default selection, NetWorker prompts you
for instructions in the Filename Conflict dialog box every time it
encounters a conflict between a recovered file and an existing file.
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This choice allows you to resolve conflicts on a file-by-file basis. For
each recovered file that has the same name as an existing file,
choose whether to rename the recovered file, discard the recovered
file, or overwrite the existing file. Figure 4-22 shows the Filename
conflict dialog box.

Figure 4-22 Filename Conflict Dialog Box

2.

In either case, select one of the following choices to solve naming
conflicts:
•

Rename the recover file: NetWorker renames the recover file
with a .R extension. If the .R file already exists, NetWorker adds
another .R.

•

Discard the recover file: NetWorker discards the recover file.
The existing file remains current.

•

Overwrite the existing file: NetWorker replaces the existing

file with the recovered file. The existing file is lost and the
recovered file becomes current.
3.
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After completing the Conflict Resolution dialog box, click Ok to
continue the recovery.

Recovering Data

Monitoring the Recover Status
After the Conflict Resolution dialog box closes, the Recover Status window,
shown in Figure 4-23, reappears as the recovery continues.

Figure 4-23 Recover Status Window

The Recover Status window lists the following information about your
recover session:
•

the number of files to be recovered and where they will be relocated; for
example:
Recovering 1 file into its original location
Total estimated disk space needed for recover is 45 KB.

If you specified a directory in the relocate dialog box, it is listed.
•

the estimated disk space required for the recovery; for example:
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Total estimated disk space needed for recover is 45 KB.

•

the name of the required backup volume and its location; for example:
Volumes needed (all on-line):
man.001 at /dev/nrst8

•

the amount of time needed to recover the file and the name of the file or
directory being recovered; for example:
VRequesting 1 file, this may take a while . . .
./TechPubs

NetWorker lists the new filenames if you chose to rename the recovered
files.
To cancel the recovery, click Cancel.
When the recovery is complete, the following message appears:
Recover completion time:...

Click Cancel to close the Recover Status window.
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5.

Archiving and Retrieving

NetWorker includes an optional Archive product for storage of data. Data
archiving is the process of taking a snapshot of files or directories as they
reside on primary media (usually disk) at a given point in time for long-term
storage on media called archive volumes. Archive volumes are similar to
backup volumes, except that their retention policy is “retain forever.”
Archive volumes never expire.
Archiving is normally performed on data associated with specific projects,
rather than on an entire system. Unlike data backup, users typically initiate
data archiving whenever they need, so a network-wide archiving policy is
usually impractical.
Note: If you are not sure if your site or your system has Networker Archive,

ask your system administrator.
The principal goals of performing a backup and archiving differ:
•

The goal of backing up data is to protect data against accidental loss or
damage. Backups should be reliable and efficient.

•

The goal of archiving is to maintain a snapshot of data in perpetuity (or
for as long as desired), and to conserve online storage space. Storage
media must be durable, safe, and reliable. These media are usually
removable, such as tape or optical disk.

Furthermore, backups are always associated with a level—full, differential,
or incremental—whereas archives are not.
After archiving is complete, NetWorker allows you to delete archived files
and directories to free disk space, or leave them in place. This option is called
grooming. However, if you need to retrieve the files someday, you should be
prepared for a wait. Your site’s policy may be to move archives offsite, so
getting them back could take a day or more. Check with your administrator
for details.
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Because archived data might be deleted from the system immediately or
eventually, NetWorker provides an extra measure of security to make sure
that archived data is correct. NetWorker verifies data in two ways:
•

media verification: NetWorker reads the archive volume and ensures
that it is writable and contains no bad spots

•

data verification: NetWorker reads data from the archive volume as if
doing a retrieve, but does not actually write any archived data back to
disk.

Like the basic NetWorker program, the Archive product consists of two
programs, an archive program for storing data on archive volumes and a
retrieval program for bring the data back to your system. If NetWorker has
been installed on your system, you will see the icons, as shown in Figure 5-1.

Figure 5-1

Networker Archive and Retrieve Icons

This chapter explains archiving data and retrieving data, in separate
sections.

Archiving Data
This section explains
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•

starting the Archive program

•

starting and monitoring an archive

•

grooming your filesystem

Archiving Data

Starting the Archive Program
To start archiving, click on the Archive icon or type this command at the
system prompt:
% nwarchive&

The NetWorker Archive window appears, as shown in Figure 5-2.

Figure 5-2

NetWorker Archive Window

This window resembles the NetWorker Backup window. See Figure 2-2 in
“Using NetWorker Windows” in Chapter 2. For details on that program,
refer to “Backing Up Data” in Chapter 4.
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Most menu choices have shortcuts elsewhere in the window. The exceptions
are “File Details” in the View menu, which produces a long listing of files in
the right-hand panel, and “Speedbar” in the Options menu, which
alternately hides and enables the speedbar buttons.
Use features of this window as follows:
speedbar

These buttons perform the following functions:
•

Change Server: switches to a different NetWorker server

•

Mark: designates a file or directory hierarchy for
archiving

•

Unmark: turns off the designation for archiving

•

Search: brings up a dialog box to help you find a named
file

•

Start: begins the archive, if you have marked files

Selection field

Shows the hostname of the chosen server and client and the
currently selected (working) directory in the panels below.
You can type a new pathname into the Selection field if
desired.

left panel

Displays the currently selected path on the client machine,
all the way up to root. To display all directories and files in
the currently selected directory, double-click the directory
folder, or choose “Expand One Level” from the Tree menu.
To display all levels of subdirectories, choose “Expand
Branch” from the Tree menu. To hide all the expanded
subdirectories, double-click again on the directory folder,
or choose “Collapse Branch” from the Tree menu.

right panel
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Displays all files in the currently selected directory, often as
a scrolling list. Files appear as pages with the corner bent
over, and directories appear as manila folders. To mark a file
or directory for archiving, click on its check box to the left.
A check mark appears in the box, as shown for the NSRman
directory in Figure 5-2. To unmark a file or directory, click
again on its check box.

Archiving Data

Tip: Marking a directory also marks all the files it contains,
as well as all subdirectories and everything they contain. To
archive most (but not all) files in a directory, first mark the
directory, and then unmark what you do not want to
archive.

Starting and Monitoring an Archive
To begin the archive, click the Start button on the speedbar, or choose “Start
Archive” from the File menu. The Archive Options window appears, as
shown in Figure 5-3.

Figure 5-3

Archive Options Window

Use features of this window as follows:
Archive Title

View the pathname of the currently selected directory.

Annotation field
Type a comment that might help somebody remember or
understand what this archive contains.
Tip: Because archives theoretically last forever, NetWorker

does not track them in the online index. Consequently,
when you retrieve archived data, the retrieve program
shows only the archives that a server has made during a
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selected period, or for a certain user. Thus the best way to
remember your archives is to create an annotation that
remains meaningful over the years or to keep a record of the
date.
Archive Pool field
Specify a volume pool for your archive. If you leave this
field blank, the volume pool defaults to Archive.
Operations list Click one of these buttons:
•

Clone: Click to clone your archive data (that is, make an
exact duplicate) on a volume other than the regular
archive volume. This action depends on the availability
of two devices, each with the proper volume mounted.
Verify their availability with your system
administrator, if necessary.

•

Verify: Click to verify that the data on archive media
matches the data on local disk.

•

Groom: Click to remove files and directories from local
disk after archiving is complete.

Clone Pool field
Enter the clone pool you wish to use, if you are cloning your
archive data (click the Clone button, as explained above).
Make sure that this volume is mounted and available. If you
specify a Clone Pool, the clone is sorted to a volume
associated with the pool you specified. If you leave this field
blank, the clone pool defaults to Archive Clone.
Archive button Click to continue the archiving process. The Archive Status
window appears to inform you of progress, as shown in
Figure 5-4.
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Figure 5-4

Archive Status Window

If you selected “Verify” in the Archive Options window, NetWorker checks
the data written on the archive volume. The archive completion report in the
Archive Status window indicates whether or not data could be verified as
correct.

Grooming Your Filesystem
If you selected “Groom” in the Archive Options window, NetWorker deletes
marked files after archiving is complete.
Note: Before you select the Groom option, return to the Archive window to
see which directories and files are marked. Make sure that you have not
marked directories or files that you wish to retain on disk.
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Retrieving Data
Retrieval is the copying of files back to local disk from the long-term storage
media called archive volumes. When you run the NetWorker retrieve
program, NetWorker displays the names of the archive save sets on that
server, listed by client name. You can retrieve a particular save set only if you
have administrator or archive user privileges for that server. You can search
for specific archives or alter the sort order of archive save sets in the viewing
list.
When you choose an archive save set to retrieve, and your administrator
ensures that the relevant archive volume (or a clone of that volume) is
mounted on the NetWorker server, retrieval can begin.
Retrieved save sets can be relocated, renamed, or allowed to overwrite
existing files of the same name, as with the NetWorker recover program.
This section explains
•

tracking archived data

•

starting the NetWorker retrieve program

•

viewing archive save set details

•

retrieving a save set

Tracking Archived Data
Archiving and backing up have different purposes. Archiving is a long-term
strategy for preserving data and conserving disk space. Backup is short-term
insurance against the disaster of data loss. To make it easy to recover lost or
corrupted files, NetWorker keeps track of backups in the online file index.
Maintaining this index requires considerable disk space. Because archives
theoretically last forever, NetWorker does not track archived files in the
online index.
Consequently, when you retrieve archived data, the windows do not show
the structure of your files and directories. It shows only the archives that a
server has made during a selected period, or for a certain user. Thus the best
way to remember your archives is to keep a record of the date, or create an
annotation that remains meaningful over the years.
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Starting the NetWorker Retrieve Program
To retrieve archived files and directories, click on the Retrieve icon or type
the following command at the system prompt:
% nwretrieve&

The NetWorker Archive Retrieve window appears, initially with no save sets
listed. To see a list of archive save sets, click the Query button.
The window fills up with data, as shown in Figure 5-5.

Figure 5-5

NetWorker Archive Retrieve Window
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Use features of this window as follows:
Search annotation for field
Type a search string (an annotation text or a portion of one)
and click the Query button, as explained below. You can use
regular expressions in the search string. All archive save
sets with matching annotations appear highlighted in the
Archives list.
Archives scrolling list
View a list of archive save sets available from the server.
Query button

Click to display a list of archive save sets. If you have
specified a search string in the “Search annotation for” field,
the save sets with matching annotations appear highlighted
in the Archives list.

Details button

Click to view details about the most recently highlighted
archive save set, as explained in the next section, “Viewing
Archive Save Set Details.”

Viewing Archive Save Set Details
To see details about the most recently highlighted archive save set, click the
Details button. The Retrieve Details window appears, as shown in Figure 5-6.

Figure 5-6

Retrieve Details Window

In this window, “name” represents the save set, “files” the number of files in
the save set, “ssid” the save set ID, and “size” the number of bytes.
This window also shows the archive annotation, which you can search for in
the NetWorker Archive Retrieve window.
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Note: There is no point in selecting multiple save sets for viewing details;
the most recently highlighted archive save set is the only one NetWorker
reports on.

Retrieving a Save Set
To select a save set for retrieval, highlight it in the Archives list, and choose
“Start Retrieve” from the File menu.
Tip: You can select multiple save sets for retrieval. NetWorker retrieves them

in the order in which they were archived, so as not to overwrite later copies
of files if you have Overwrite existing files selected.
The Retrieve Status window appears, as shown in Figure 5-7.
:

Figure 5-7

Retrieve Status Window

Use features of the Retrieve Status window as follows:
Archives list

View all archive save sets selected for retrieval in the
NetWorker Archive Retrieve window.
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Relocate to field
Specify a new or existing directory where retrieved files can
be copied.
Overwrite existing files
Select to cause NetWorker Retrieve to replace any files on
local disk with the same pathname as files retrieved from
the archive volume.
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Ok button

Click when you are ready to start the retrieve. The
appropriate archive volume(s) must be mounted
beforehand.

Cancel button

Click to stop a retrieve in progress, or to dismiss the
Retrieve Status window before retrieval has begun.

Status field

View informational messages that inform you of progress of
the retrieve.

Appendix A

A.

Error Messages

NetWorker provides user-friendly error messages that have
easy-to-understand explanations. This appendix provides you with further
information and solutions to assist you with your backups and recoveries.

Error Messages for Backup
NetWorker displays an error message if a backup cannot be successfully
completed. Backup error messages are as follows:
Nothing marked for backup

Problem:

Starting backup without marking any files.

Solution:

Mark at least one file before starting the backup.

Unable to start backup

Problem:

Error starting the backup (NetWorker could not execute the
save command).

Solution:

Contact the system administrator. There is a problem either
with the NetWorker software or with your client
configuration (for example, an incorrect pathname).

Your system is not a registered client.

Problem:

The server you have chosen for your backups does not have
your system configured as a NetWorker client.

Solution:

Contact the system administrator. Your system needs to be
added to the server‘s list of recognized clients.
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Error Messages for Recover
An error message is displayed when NetWorker is unable to recover a file.
Recover error messages are as follows:
These are files marked for recovery.
Continue to ignore the marked files, or cancel to stay with
this client.

Problem:

Changing clients or changing filesystems when files are
marked.

Solution:

You have the option to continue changing clients. In this
case, the marked files will not be recovered. Alternatively,
you can cancel to stay with the current client and retain your
marked files.

(For root user) Only 10 KBytes available (15 KBytes free) in
/directory. Filesystem will be greater than 100% full after
recover is complete. Proceed with recover command at this
time? [n]
(For non-root user) No disk space available (15 KBytes free) in
/directory. The estimated recover size of 10 KBytes will
not fit on this filesystem. Proceed with recover command at
this time? [n]
Problem:

There is not enough free space in the filesystem to recover
the requested files.

Solution:

Reduce the number of kilobytes in the recovery by reducing
the number of marked files. Relocate the recovery into
another directory with more space. If you are recovering
over existing directories, you may be able to proceed with
the recovery, since files might be overwritten.

Invalid time format
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Problem:

The time specified in the Browse Time field was invalid.

Solution:

Enter the browse time using a valid format. Valid formats
are
•

hh:mm:ss (24-hour clock); for example, 15:30:00

•

hh:mm (am, pm) (PDT) mm/dd/(yy); for example,
5:30 pm PST 7/4/95

Error Messages for Both Backup and Recover

•

monthname dd (yy); for example, October 31

•

last Friday, next Friday, third Friday

•

+ or - 3 seconds, minutes, hours, weeks, months, years

•

now

Nothing in index at this time

Problem:

There are no entries in the index for the browse time that
was specified, or no backups were performed at that time.

Solution:

Enter another browse time close to this one until you find
the index entries you are looking for.

Unable to relocate to /directory

Problem:

NetWorker was unable to relocate the recovered data to the
specified path.

Solution:

Enter a valid pathname in the Relocate dialog box and start
the recovery again. You must have write permission for the
directory you wish to use.

Error Messages for Both Backup and Recover
Some of NetWorker‘s error messages are the same for both a backup or
recover that is unsuccessful. The error messages used for both backups and
recovers are as follows:
There are files marked for backup or recovery. Continue to
ignore the marked files or cancel to stay with server.

Problem:

You cannot change servers after you have marked files.

Solution:

You have the option of continuing changing servers. If you
change servers, the marked files are not backed up or
recovered. You can cancel to stay with the current server
and retain your marked files.

Bad start path

Problem:

Specifying an invalid starting path for a search.

Solution:

Enter a valid pathname as a starting point in the search
dialog box.
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No match

Problem:

Nothing matched on this search command.

Solution:

Enter a different pattern or a different starting path.

Bad search pattern

Problem:

The search pattern specified is not valid.

Solution:

You can use the IRIX shell pattern characters to specify a
search pattern.

Unable to expand path
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Problem:

The path specified in the selection field does not correspond
to anything in the index or filesystem.

Solution:

Enter a valid pathname in the selection field.

Appendix B

B.

Commands for Backup and Recovery

In addition to a graphical user interface, NetWorker has backup and recover
commands similar to IRIX commands. These commands are entered from an
IRIX shell. To use the NetWorker commands from an IRIX shell, the
NetWorker software must be installed on the NetWorker server, and your
system must be configured as a NetWorker client by the system
administrator.
Use the save command to back up data:
# save -s server pathname

Use the recover command to recover data:
# recover -s server -c client pathname

In addition, the Recover program provides an interface that allows you to
browse files and control your recoveries. When you enter the recover
command, the NetWorker prompt appears. You can use the commands
listed in Table B-1.
Table B-1

recover Commands

Command

Description

?

Displays list of Recover program commands.

add filename

Adds filename to the recover list.

cd dir

Changes directory to dir.

changetime

Changes the browse time of online index.

delete filename

Deletes filename from the recover list.

dest

Verifies destination directory for recovered files.

force

Overwrites existing files.
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Table B-1 (continued)
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recover Commands

Command

Description

help

Displays list of Recover program commands.

list

Lists the files in the recover list.

ls -f filename
ls -lf filename

Lists filename with file type information.

ls -l filename
ls -ll filename

Lists filename using long format.

ls filename

Lists filename.

noforce

Does not overwrite existing files.

nsrwatch

Monitors NetWorker server activity.

pwd

Displays name of current directory.

quit

Exits the Recover program.

recover

When entered at the system prompt, starts the
Recover program; when entered at the recover>
prompt, starts the recovery.

relocate dir

Specifies new directory location for recovered files.

verbose

Toggles verbose or quiet mode for Recover status
messages.

versions filename

Displays backup history of file filename. filename
can be either a file or a directory.

volumes filename

Lists volumes needed to recover marked files.
filename can be either a file or a directory.

Appendix C

C.

Requirements for NetWorker Clients

For Silicon Graphics NetWorker clients to use the NetWorker server to back
up and recover files, clients must
•

be running IRIX 5.3 or 6.x

•

have NetWorker client software installed (see “Installing NetWorker
Software on Clients” in Chapter 1)

•

be running the nsrexecd(1M) daemon (it is started automatically by inst
at installation time)

•

recognize the NetWorker server (see “Installing NetWorker Software on
Clients” in Chapter 1)

•

be recognized by the NetWorker server (the Clients window of the
networker(1M) command running on the server must list the client)

Individual licenses for NetWorker clients are not installed on the clients;
only the NetWorker server requires licenses.
For the optional Archive and Retrieve programs, a NetLS license must be
installed on the server and loaded into the NWServer program with nsrcap.
This procedure is explained in the IRIX NetWorker System Administrator’s
Guide.
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back up (v.)
To store the directories and files on your workstation on tape or another
storage medium.
backup (n.)
A copy of the directories and files on your workstation on a tape or another
storage medium.
backup volume
Any type of storage media that your server can back up to: magnetic tape,
floppy disk, or optical disk.
collapse
To change the view to display only the top level of a highlighted directory in
a window.
index
A database on the NetWorker server that contains an entry for every file
backed up.
expand
To change the view to display all the levels of a directory in a window.
media device
The device that is attached to the NetWorker server for transferring and
recovering data that has been saved.
NetWorker client
A system on a network that backs up and recovers data using NetWorker.
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NetWorker server
The system that backs up all the other systems on a network according to a
schedule and maintains an online index of everything it backs up.
recover (v.)
To replace a lost file with a copy from the NetWorker server.
selection
The name of the volume, directory, or file highlighted in any window.
tree structure
A view that displays the contents in a window in a hierarchical form.
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Index

A
archive, 61-67
and backup, 61
and file index, 68
clone, 66
monitoring, 67
options, 65-66
starting, 65-66
tracking data, 68
verifying data, 62, 66-67
volume, 61
Archive Clone pool, 66
authorized system, 45

B
backup, 15-22, 38-45
and archive, 61
canceling, 44
closing window, 22
completion message, 45
completion time, 44
error messages, 73, 75-76
excluding files, 19
history, 48-50
marking directory, 18-19
media
location, in Versions window, 48
saving space, 42
monitoring, 20-21, 44-45
options, 41-43

program, starting, 6
server, changing, 39-40
shortcut, 37
start time, 44
starting, 20, 40
status information, 44
time
displayed, 33
in Versions window, 48
versions, identifying, 33
volume
listing for recover, 55-56
location, in Versions window, 48
Backup window, 15-22
block device icon, 11
browse
filesystem, 29-36
index, 24
selecting level, 30-31
time, 9, 51-53
formats, 53, 74
Browse time command, 52

C
cancel
backup, 44
recover, 27
change
NetWorker server, 39-40, 46
Archive window, 64
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speedbar button, 8
selection, 36
Change Server speedbar button, 8
character device icon, 11
checkbox for marking and unmarking files, 31-32
client, 1
changing, 74
choosing for recover, 47
error, 73
installing software, 2-4
not registered, 40
requirements, 79
subsystems, 3
clock cursor icon, 11
clone archive, 66
closing a window, 36
Collapse Branch command, 31
commands, 77-78
compressing files, 20, 41-42
conflict resolution, 26

D
data verification, 62
directory
display, 9, 16
expanding, 17
mark for backup, 18-19
marking, 31-32
selecting versions, 51-53
unmarking, 32
display directory and file, 9

E
error messages
backup, 73

84

backup and recover, 75
recover, 74
exit, 22
window, 36
Exit command, 36
Expand Branch command, 31
Expand One Level command, 17, 24, 30
expanding directory, 17

F
file
compressing, 20, 41-42
deleted, recovering, 51
details, viewing, 33-34
display, 9
excluding from backup, 42-43
finding, speedbar button, 8
index and archive, 68
listing marked, 53-54
marking, 31-32
speedbar button, 8
naming conflict, 26
relocating, 56-57
renaming or overwriting, 57-58
retrieved, relocating, 72
search, speedbar button, 8
searching, 34-35
Archive window, 64
unmarking, 32
speedbar button, 8
version, 48
selecting for recover, 48-50
File Details command, 33
File Names command, 33
filesystem, sufficient space for recover, 74
Find speedbar button, 8
folder icon, 9

G
grooming, 61, 66-67

H
Help menu, 8, 12-14
help topics, 13
highlighted
file icon, 11
folder icon, 10
open folder icon, 10

I
icons, graphical, 9-11
index, 1, 21, 22, 48
browsing, 24
InSight manuals, xv, 3
installing NetWorker software on clients, 2-4
IRIX version required, xiii

K

file, 31-32
for recover, 24-25
listing marked files, 53-54
subdirectory, 19
Mark speedbar button, 8, 18, 31
media
verification, 62
volumes needed, 27
menu bar, 7-8
menus, using, 6
monitor
backup status, 20-21, 44-45
recover, 26
mount point, 19
icon, 10

N
naming conflict, 26
NetWorker version, xiii
nsrhost alias, 4
nwarchive command, 63
nwbackup command, 6
nwrecover command, 6
nwretrieve command, 69

keyboard shortcuts for menus, 6
O
L
open folder icon, 9
listing backup volumes for recover, 55-56
P
M
mark
Archive window, 64
directory, 18-19, 31-32

pattern
changing, 43
deleting, 43
excluding from a backup, 42-43
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product support, xvi

Q
Quick Tour, 15-28
backup, 15-22
recover, 22-27
review, 28

R
.R extension, 26, 27, 58
recover, 22-27, 45-60
canceling, 60
cancelling, 27
choosing client, 47
deleted files, 51
error messages, 74-76
insufficient space, 74
monitoring, 59-60
preparing to, 45
program, starting, 6
selecting versions of files, 48-50
server, choosing, 46
shortcut, 38
starting, 26
volumes needed, 27, 55-56
recover commands
add, 77
cd, 77
changetime, 77
delete, 77
dest, 77
force, 77
help, 77, 78
list, 78
ls, 78
noforce, 78
nsrwatch, 78
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pwd, 78
quit, 78
recover, 78
relocate, 78
verbose, 78
versions, 78
volumes, 78
Recover window, 22-25
File Details, 33-34
recovery, see recover
reducing network traffic, 41, 42
reference pages, xv
Release Notes, xv
release number of NetWorker, xiii
Relocate command, 56
relocating retrieved files, 72
retrieve, 61-62, 68-72
overwriting existing files, 72
relocating files, 72
starting, 69-70

S
save command, 77
save set
archive, viewing details, 70-71
retrieving from archive, 68, 71-72
scrollbar, 11
Search command, 34-35
Search speedbar button, 34-35
searching for files, 34-35
Archive window, 64
Selection field, 9, 16
selection panel, 9
server, 1
changing, 46
documentation, xv

specifying, 6
sheet icon, 10
Show Marked command, 54
speedbar, 8
Archive window, 64
Start speedbar button, 8
subdirectory, marking, 32
subsystems for clients, 3
symbolic link icon, 11

T
tree structure, 9, 10, 24, 30

U
unmark
Archive window, 64
directory, 32
file, 19, 32
Unmark speedbar button, 8, 19, 32

V
verifying archived data, 62, 66-67
version of NetWorker, xiii
Versions window, 48-50
viewing a directory, 30-31
Volumes command, 55

W
window, 7-11
controls, 11
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